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Chapter 1. Introduction

LSAT has been developed by ASML, ESI (TNO) and TU/e. The acronym LSAT stands for Logistics
Specification and Analysis Tool. The figure below shows the main functionality of LSAT
Embedded Systems

Innovation BY TNO

Logistics Specification and Analysis Tool:
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Chapter 2. Installation
0 The LSAT distribution is currently only available for Windows.

The LSAT tool is available as a full product and also as a feature for the Eclipse IDE.

2.1. Install as Eclipse Product

In order to install it as a full product, follow the instructions:

* Download LSAT IDE "zip" file and extract it to a folder.

* Double click the “Isat.exe” file, the tool will start.

.« & ecClipse

LSAT

(Logistics Specification and Analysis Tool)

Loading arg.eclipse.ui.themes

2.2. Install as Eclipse Feature

The instructions to install LSAT from scratch as feature for the Eclipse IDE through the update site
repository are as follows:

* Download an Eclipse IDE (Neon) https://www.eclipse.org/downloads/packages/eclipse-ide-java-
developers/neon3

* Unzip the IDE, e.g., to the directory "Isat";

« Start the Eclipse IDE via "lsat/eclipse/lsat.exe";

 Select as usually a workspace directory;

* As the Eclipse-IDE is opened, select Help » Install New Software...;

 Click "Add” and put a name (“LSAT update site”) and location: https://Isat.esi.nl/repository/ and
click “OK”;

 Select these features and complete the remaining steps of the installation process.

2.3. Logistic perspective.

Once you have installed LSAT, you can choose the Logistics perspective following the instructions as
below:


https://lsat.esi.nl/lsat-win32.win32.x86_64.zip
https://www.eclipse.org/downloads/packages/eclipse-ide-java-developers/neon3
https://www.eclipse.org/downloads/packages/eclipse-ide-java-developers/neon3
https://lsat.esi.nl/repository/

* In Eclipse: select Window > Perspective » Open Perspective » Other... > Logistics

* Or, click to the icon of perspective (right-up of the window) and select Logistics as it is shown in
the figure below:
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Chapter 3. Motion Calculator

A motion calculator is used to calculate the time it takes for a move to complete. The default Third
order point-to-point motion calculator is capable of calculating time for point-to-point moves with a
3" order motion profile. It also supports passing moves, with the constraint that for all sub-moves
the motion profile is the same.

LSAT provides an extensible design for adding custom motion calculators. Creating a custom
motion calculator requires knowledge about Eclipse plug-in development and Java. As such the
instructions can be found in the design documentation of LSAT.

When a custom motion calculator is installed in the LSAT environment, it can be selected via the

Window > Preferences » Logistics » Motion Calculator menu.
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| type filter text | | Motion Calculator Swcy v w
EEF A
» EMF Compare

Configures the motion calculator to use for this workspace.
Meotion calculator

» Help
(®) Third order point-to-point
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s Java () Custom motion calculator
~ Logistics [ ] Show debug information in chart view
w  Activity
Compiler
Refactoring
Syntax Coloring
Temnplates
w Dispatching
Compiler
Refactoring
Syntax Coloring
Temnplates
w Machine
Compiler
Refactoring
Syntax Coloring
Templates
Muotion Calculater
» Setting
Medel Editor W
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Restore Defaults | Apply




Chapter 4. Logistics Specification

4.1. Create New Project

You can create a new specification by using the File > New menu on the Workbench menu bar. Start
by creating a logistics project as follows:

1. From the menu bar, select File > New > Project...

& Mew Project O X

Select a wizard p—

Wizards:

type filter text

= Java =
~ = Logistics
T Logistics Project
= Model to Model Transformation
& Plug-in Development
(= Sinius v

@ < Back Next = Finish Cancel

2. In the New Project wizard, select Logistics > Logistics Project then click Next.

3. In the Project name field, type your name as the name of your new project, for example
"Tutorial".

4. Leave the box checked to use the default location for your new project. Click Finish when you

are done.

The wizard creates a machine specification in the project and configures the project for graphical
editing. It will open the machine editor, allowing the user to add the resources and peripherals to
the machine.

Within the project, the different types of specification can be created:
* machine specification
* settings specification
* activity specification
* activity dispatching specification

A new project always starts with machine specification, since it specifies the resources with their
peripherals.



If it is the first time a file is created in the project, a pop up dialog about adding
Xtext nature to the project will appear. Click Yes to continue.

- .
= Add Xtext Nature =

@=% Do you want to add the Xtext nature to the project 'test'?

[ Yes || Mo || Caneel

4.2. Create Machine Specification

Machine specification with file extension “machine” is used to specify the resources with their
peripherals. This file is created automatically with the new project. It usually has the same name
with the project, e.g. “tutorial. machine”.

A machine specification file can be opened to edit. Below are the basic concepts and small examples
within a machine specification file.

(r) Ctrl+Space can be used to see the hints for the next step in textual editors.
-

Machine Tutorial @

PeripheralType Clamp { @
Actions {
clamp
unclamp
}
}

PeripheralType Motor { ®

Actions {
apply_brake

}

SetPoints {
X [m]
Y

}

Axes {
X [mm] moves X
Y [mm] moves Y

}

Conversion "X=X/1000;Y=Y/1000" @
}
Resource Robot1 { ®

C: Clamp

M: Motor {

AxisPositions { ®



X (Left, Right)
Y (Above)

}

SymbolicPositions { @
Above_Left (X.Left, Y.Above)
Above_Right (X.Right, Y.Above)
Below Left (X.Left)
Below_Right (X.Right)

}
Profiles (normal, slow)
Paths { ©

Above_Right --> Below_Right [Y] profile slow
Below_Right --> Above_Right profiles normal, slow @@
Above_Left [X] <-> Above_Right profile slow
FullMesh {
profile normal
Above Left
Above_Right
Below_Left [Y]
}
}
}
}

@ Machine - the unique name for a machine
@ PeripheralType (unmovable) - it only declares actions

® PeripheralType (movable) - it may declare actions, but it also declares set points and axes.
The SetPoints relate to the physical coordinate system of the peripheral on which the motion
profile settings are applied.
The Axes relate to the symbolic coordinate system on which the physical locations are applied.
An axis specifies which set points change when its value changes. The unit is specified between
the square brackets [] and defaults to m(eters).

@ Conversion - If the unit of an axis differs from the unit of its set points a conversion script is
required. The conversion needs to convert a physical location in the symbolic axes coordinate
system to a physical location in the physical set points coordinate system. For each axis a
variable is available containing its coordinate value and for each set point a variable should be
set containing the set point value.

NOTE: The script language is JavaScript

® Resource - it defines its peripherals. For every movable peripheral in a resource its symbolic
positions and paths need to be specified.

® AxisPositions (optional) - if a peripheral has multiple axes and the symbolic positions can be
categorized in axis positions, these axis positions may be declared in this section. In this case
only a physical location per axis position is required in the settings file for this axis in stead of
one location per symbolic position.

@ SymbolicPositions - declares the symbolic positions for this peripheral. Optionally a symbolic
position may be expressed in its axes positions. If no axis position is specified (i.e. Below_Left
and Below_Right) the symbolic position will automatically be added to the axis positions for the



axis.
Profiles - declares the speed profiles to use for the paths.

© Paths - declares which moves are allowed in the system. If a path is declared between two
locations the move is allowed using the speed profile as specified by the path. For each end
point of a path its settling axes can be specified as a comma separated list between square
brackets []. Different types of paths are available:
unidirectional path - indicated by an unidirectional arrow -->, only a move from left to right is
allowed
bidirectional path - indicated by a bidirectional arrow <->, both moves from left to right and right
to left are allowed
full mesh - indicated by keyword FullMesh, all moves from a location to another location in the
full mesh are allowed.

@ Profiles - You can specify more than one speed profile per path by means of the profiles
keyword.

4.3. Create Settings Specification

Settings specification with file extension “setting” is used to specify physical settings for peripherals
or peripheral actions. Within the project, create a “.setting” file by using the new file wizard.

0 Only 1 setting file is allowed per project

7 If another file is selected while running the new file wizard, this file will be
- automatically imported



= Mew File O >

File

Create a new file resource. J

Enter or select the parent folder:

tutorial |

-
'?' -

s L tutorial

File name: | tutorial.setting

Advanced > >

Fr—t

2 Finish Cancel

A property specification file is opened. Below are the basic concepts and small examples within a
property specification file.

O Ctrl+Space can be used to see the hints for the next step in textual editors.
w



import "tutorial.machine" @

Robot1.M { @
Timings { ®
apply_brake = 100e-3
}
Axis X {
Profiles { @
0.

stow (V = 0.5, 3 =0.5 S=20.1)

normal (

5, A
1, A

1
)
~
—
1
=
~

}
Positions { ®
Left (min = -100, max = -200, default = -150)
Right = 300.0
}
}
Axis Y {
Profiles {
slow (V= 0.5, A=20.5 ] =
normal (V = 1.0, A =1.0, ]
}
Positions {
Above = 150.0
Below_Left = -160.0
Below_Right = -150.0
}
}
}

0.5, S
=1

Robot1.C {
Timings { ®
clamp = Normal(mean = 1.1, sd = 0.1)
unclamp = 0.9
b
}

@ import - first step in a property specification is to import a machine specification file. After that,
it is allowed to specify properties for peripherals or actions.

@ Robot.M - for a movable peripheral, it is required to set the motion profiles to its profiles and
physical relative locations to its symbolic positions. These properties are always set per axis.

® Timings - if a peripheral contains actions, a timing must be specified. There are different types
of timing available:
Fixed value (no keyword) - One fixed value, use if the timing does not vary.
Normal - The variation is specified using a normal distribution. Parameters: mean, sd (standard
deviation)
Triangular - A triangular distribution as described here. Parameters: min, max, mode.
Pert - A Pert distribution as described here. Parameters: min, max, mode, gamma.
NOTE: In addition to the distribution specific parameters, it is possible to specify a default value

10


https://en.wikipedia.org/wiki/Normal_distribution
https://en.wikipedia.org/wiki/Triangular_distribution
https://www.riskamp.com/beta-pert#the-pert-distribution

for a distribution. If present this value is used for scheduling. The distributions are used for
stochastic impact analysis. If no default is specified the mode of the distribution will be used.

@ Profiles - motion profiles need to be assigned to each profile individually. They can be either
Third-order profile (VA]) or Second-order profile (VA). Optionally a settling time (S) can be
specified per profile.

® Positions - physical relative locations can be specified as a set of maximum, minimal and
default values or one fixed value.

4.3.1. Plotting a timing distribution

To gain insight in the probability density for timings in a distribution, the probability density factor
(PDF) can be plotted in the Chart View. To do this, please select the distribution keyword of the
requested distribution and select the 'Plot in Chart View' item from the context menu, as illustrated
in the next figures

38< Robot.C { Quick Fix Ctrl+1
31= Timings {
32 clamp = [ til(mean = 1.1, sd = @.1) Source v
33 unclamp = 2.9 . .
34 } Find References Ctrl+Shift+G
5} ) .
- b= Add to Snippets...
- . - P - = | 3
Properties Problems '] Error Log Console [a Run As
Debug As 3
Profile As 3
Validate

lad Plotin Chart View

r . .. .
O The chart view also shows the mean marker, this is the value used for scheduling.
w
[T Properties 5! Problems @] ErrorLog & Console gChart‘-flew ] = 0
Probability Density Function nd
4
23
g,
T - =
aq 3
a rmean = 1. 700000
0.7 0.8 0.2 1.0 1.1 1.2 1.3 1.4 1.5 1.6
Time A
-
< 1 | F

4.4. Create Activity Specification

Activity specification with file extension “activity” is used to specify activities of a machine. Within
the project, create an “.activity” file by using the new file wizard.

7 If another file is selected while running the new file wizard, this file will be
- automatically imported

An activity specification file is opened. Below are the basic concepts and small examples within a
activity specification file.

11



(o . . .
O Ctrl+Space can be used to see the hints for the next step in textual editors.
-

import "tutorial.machine" @

activity MoveRobot { @
prerequisites { ®
Robot1.M at Above_Right

}
actions { @

C: claim Robot1

R: release Robot1

A1: move Robot1.M to Below_Right with speed profile slow

A2: Robot1.C.unclamp

// Schedule A3 to end together with A4 (As Late As Possible)
A3: Robot1.C.clamp ALAP ®

A4: move Robot1.M to Above_Right with speed profile normal

}
action flow { ®

C->A1 ->A2 -> |ST ->A3 ->|S2 ->R
|S1 -> A4 > |S2 @

@ import - first step in an activity specification is to import a machine specification file.

@ activity - specify activities by defining individual actions and dependencies among these
actions.

® prerequisites - specify the initial location for all movable peripherals for this activity.

@ actions - there are four types of actions:
Resource claiming — action name, claim keyword and resource
Resource releasing — action name, release keyword and resource
Peripheral action — action name, resource, peripheral and peripheral action
Move - action name, move keyword, resource, peripheral, symbolic position destination and
speed profile.
The default Move action is point-to-point (stop at target position). However, it can be changed to
passing. By using the keyword, you specify that the action should not stop at target. Another
name for passing is event-on-the-fly. This feature is used to concatenate Move actions and the
user needs to explicitly enable it. Here is an example declaration of a passing move:
A1: move Drill.ZR passing UP with speed profile normal ALAP
The images below illustrate the difference between two types of Move actions.

12
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Figure 1. Movement point-to-point.

Velocity vs. time
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Figure 2. Movement on-the-fly event.

® ALAP / ASAP - Each action has scheduling type. There are two types available: As Soon As
Possible (ASAP) and As Late As Possible (ALAP). If no value is specified at the end of the action,
then the scheduling type is ASAP by default. To change it to ALAP you can add the ALAP
keyword at the end of the action. For more information, see section Constraints for ALAP and
ASAP scheduling actions.
Resource claiming — ASAP by default, cannot be changed.
Resource releasing — ASAP by default, cannot be changed.
Peripheral action — ASAP by default, can be changed to ALAP.
Move - ASAP by default, can be changed to ALAP.

® action flow - uses arrows to specify action flow. A1 ~ A2 represents A2 starts when A1 finishes.

13



@ syncbar - used to specify synchronization, for instance A2 ~ |S1 ~ A3 and |S1 — A4 represents
A3 and A4 start simultaneously after A2 finishes.

4.4.1. Constraints for ALAP and ASAP scheduling actions

There are a number of validation rules implemented in LSAT for the different scheduling
algorithms. In general you have to keep two things in mind:

1. The scheduler algorithm prefers ASAP scheduling over ALAP scheduling.

2. A concatenated move with events on-the-fly may be delayed as a whole, but not in between its
events.

Scenario 1

Consider action Al in the ALAP scenario 1 with scheduling type ALAP and a sole successor (A2),
which is not a syncbar. In this case the ALAP keyword does not have any effect due to the ASAP
(default) scheduling of action A2.

Eclipse will show you the following warning:
A The ALAP keyword does not have any effect for action Al.

cloim I

_T' &, Robot1
\'.j'c
Al: unclamp 4‘
ALAP
k]

Figure 3. ALAP scenario 1

Scenario 2

Consider move Al in ALAP scenario 2 which is passing. As its successor is a syncbar, and this
syncbar has more than one predecessor, then move A1 must be ALAP. As moves Al and A3 should
be concatenated, there cannot be any delay between them. As action A2 might cause such a delay,
move Al needs to be scheduled ALAP to guarantee concatenation.

Eclipse will show you the following error:

o Move A1l must be set to ALAP to guarantee concatenation with successor move A3.

14
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Figure 4. ALAP scenario 2

Scenario 3

Consider move A3 in ALAP scenario 3 which is a continued move of Al. Move Al continues into
move A3 by means of the passing keyword and therefore move A3 cannot be delayed. As the
predecessor of move A3 is a synchar, move A3 must be ASAP to guarantee concatenation.

Eclipse will show you the following error:

o Move A3 must be set to ASAP to guarantee concatenation with predecessor move
Al.

15
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Figure 5. ALAP scenario 3

4.4.2. Plotting a move

To gain insight in the motion path of a move, the motion path can be plotted in the Chart View. To
do this please select the move keyword of the requested move and select the 'Plot in Chart View'
item from the context menu, as illustrated in the next figures

o uane Lame Pﬂbbcb
A3: Robot.C.clamp Paste Ctrl+V
A4 m Robot.M to Abov

=
LEV

Rename Element Alt+5Shift+R
action flow { // <5> Validate
C -» Al -» A2 -> |51 -> |
|51 -» | Quick Fix Ctrl+1

00~ N B

} Source 3

B
&= 0
e

Find References Ctrl+5Shift+G
P Bz Add to Snippets...

Run As 2
Debug As 2
Profile As 2
Validate

at  Plotin Chart View

do consoles to display at this time.
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4.5. Create Activity Dispatching Specification

Activity dispatching specification with file extension “dispatching” is used to specify a sequence of
activities to schedule. For more information about scheduling, see section Schedule Activities.
Within the project, create a “.dispatching” file by using the new file wizard.

7 If another file is selected while running the new file wizard, this file will be
- automatically imported

An activity dispatching file is opened. Below are the basic concepts and small examples within a
activity dispatching file.

O Ctrl+Space can be used to see the hints for the next step in textual editors.
w

import "tutorial.activity" @

throughput {
iterations: 1 @
iterations.Robot1: 2

activities { ®
MoveRobot ("First product")

}

activities {
offset: 6.00 @
MoveRobot ("Second product")

}

@ import - first step in an activity dispatching is to import an activity specification file.

@ iterations - specifies the default number of iterations - for all resources - or the number of
iterations for a specific resource (see next line). When omitting the throughput section the
default number of iterations will be set to 1. For more information about iterations see section
Specifying the number of iterations.

® activities - within an activity sequence one or more activities can be included. These activities
will be scheduled as parallel as possible adhering to the claim/release strategy. If activities

17



cannot be scheduled in parallel the order of this section is applied.
Optionally a description can be added to the activity

@ offset - optionally an offset can be defined for an activity sequence. The scheduler will ensure
that these activities will not be started before the offset time.

4.5.1. Specifying the number of iterations

The number of iterations is used to calculate the throughput per resource, as explained in section
Calculating the Throughput per Resource. In the activity dispatching specification example above
the Robot resource performs activity MoveRobot twice, once for the "first product” and once for the
"second product". In this case the number of iterations can be used for the calculation on how many
products per hour can be processed by the Robot resource.

é The number of iterations does not influence the Schedule Activities or
Conformance Check.
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Chapter 5. Graphical Viewers

5.1. Convert to Modeling Project
In order to open a graphical viewer, the project needs to be converted to a modeling project.

Open Modeling perspective

r Bl
& Open Perspective ‘ E@g

E=cvs Repository Exploring

#5 Debug

o Git

&) Java (default)
$,J.|a\.ra Browsing
EJJava Type Hierarchy
qﬁlModeling

(1) Planning

[ Resource

QDTeam Synchrenizing
XML

[ oK ] ’ Cancel ]

Right click on the project folder —» Configure — Convert to Modeling Project

Configure P Convertto Madeling Praoject
Source 3 Remove Xtext Mature

. C rtto M Project
Properties Alt+Enter pnvertto Waven Froje

After conversion, it shows the structure of files in the Modeling Explorer.

B Model Explorer 532

type filter text

4 ¥ tutorial
=i, Project Dependencies
> = analysis
representations.aird
Eh," tutorial.activity
& tutorial.cif

w7

w7

Eh," tuterial.dispatching

w7

4 Eh," tuterial.machine
4 | 4 Machine Tutorial
4 < Resource Robot
<+ Peripheral C
> 4 Peripheral M
» 4 Peripheral Type Clamp
> 4 Peripheral Type Motor
2" tutorial setting
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5.2. Add Viewpoints Selection

Right click on the project folder, select Viewpoints Selection.

A

& Model & Viewpoints Selection
typefilterff (52 Create Representation
4 [ test
- Mew ¥
=
Go Into
| B Copy Ctrl+C
> B _
™ Paste Ctrl+V
=

The following viewpoints are available:

Machine shows the resources with their peripherals and illustrates symbolic
position graphs for movement-based peripherals.

Activities shows activity diagrams based on activity specifications.

Physical settings  shows settings for motion profiles and physical locations.

Check the relevant viewpoints and click OK.

i '
& Viewpoints Selection uﬂlﬂ

Selected viewpoints

Change viewpoints selection status (see
tooltip for details about each viewpoint)

=2 Activities
% Physical settings
dMachine

® [ oK ] [ Cancel l

5.3. Generate Graphs

5.3.1. Peripheral types in machine
Target element: a machine

Right click on a target element, select New Representation and choose the corresponding Peripheral
Types for the target element.

20



4 ¥ tutorial
=i, Project Dependencies
> representations.aird
> Eh," tutorial.activity
> Eh," tuterial.dispatching
4 Eh," tuterial.machine
> | @ Machine Tutd
> Eh," tutorial setting

Mew Representation k| & Machine Tutorial

Contral... & Peripheral Types

Export representations as images

The peripheral types graph for the target element includes all action and movement based
peripheral types for the target element.

r L . . .
O This viewer can also be used to edit the peripheral types by using the palette.
-
2 Peripheral Types 2 = 0
0F v Bt || ey e s e gt | palete | b
2 clamp I Motor 1 m‘zﬂ eQ--
i3 damp ,__:j)( = £
&8 unclamp f; 1$I Peripheral type
v (4 Setpoint
w4 apply_brake J-Axis
L4 Action
4 F

Double clicking a peripheral type will open its textual representation allowing to
O specify the detailed information, like the conversion pattern. Typing Ctrl+Enter in

the text editor will save the changes and typing Escape will cancel them.
2 Peripheral Types 2 = 8
spvFTaeMiv| At B B XK BT A~E| S Iy — v @ | Palete b
1 Clamp 1 Moator PeripheralType Motor { - - |E @S-
Actions { = p
"’_} - "'—'1 : apply_brake .
2 unclamp fY 1 111 Peripheral type
X . §
oy Se;Polnis{ [% Setpoint
w4 apply_brake v Je Axis
Lxes{ = i Action
X [mm] mowves X
¥ [mm] mowves Y
}
Conversion "X=3/1000:¥=Y,/1000"
! !
4 »
1 »

5.3.2. Resources and peripherals in machine
Target element: a machine

Right click on a target element, select New Representation and choose the corresponding Machine
for the target element.
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4 ¥ tutorial
=i, Project Dependencies
> representations.aird
> Eh," tutorial.activity
> Eh," tuterial.dispatching
4 Eh," tuterial.machine

} Q‘ Machina Tutarial
. 2 tutorial Mew Representation b | & Machine Tuterial

& Peripheral Types

Control...

Export representations as images

The graph for the target element includes all resources with their action-based and movement-
based peripherals for the target element.

(r) This viewer can also be used to edit the resources and their peripherals by using
- the palette.
£ Machine Tutarial 3 = 0
B Biv| S| O v m [ b
&, Robot “heag--
":i C: Clamp = £l
VLH &, Resource
(J Peripheral
4 F

5.3.3. Axis position graph for peripheral
Target element: a movable peripheral defined in a resource

Right click on a target element, select New Representation and choose the corresponding Axis
positions for the target element.

4 I tutorial.machine
4 &b Machine Tutorial
4 % Resource Robot
W Peripheral C

al F_’eripheral New Representation »| & Axis positions for RobotM
> Per!pheral Typ Control & Symbolic positions for RobotM
+ ¥ Peripheral Typ & Motion profile settings for Robot.M

The axis position graph for the target element includes specific information about axes and
corresponding positions.

@ peripheral M

L x &y
Left |[+] Above
Right &b

The axes in a axis position graph are shown as compartments, and the positions associated to an
axis are shown under the axis. For example, in the figure above, the position Above is associated to
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the axis Y.

Adding/removing axes

To add a new axis to a peripheral, select the empty canvas and select the desired axis from the
Available axes list, and press Add Axis on the right side.

~ Axis Positions

Available axes (@)

S

To remove an axis from a peripheral, select it and press Delete.

0 Deleting an axis will also delete all corresponding positions.

Adding/deleting positions

The positions can be associated to an axis by selecting the Position tool from the Axis Positions
Editor Tools palette on the right side, and selecting the axis compartment.

By default, name of the newly created position is new. The name of a position can be changed by
selecting it, typing the name directly and pressing Enter. Alternatively, the name can be changed
using the properties editor, as shown in the figure below.

Semantic Property Value
Style 4 Position Above _
= | Name "= Above
Appearance

To delete a position, select it and press Delete.

If a position is specified in both axis position graph and Settings Create Settings
o Specification, deleting that position from the axis position graph will also delete it
from the Settings specifications.

Validation

An axis must not be added more than once. To validate this property, right click on the canvas and
click Validate diagram. If any axis is added more than once, a red error sign will appear on those
axes, as shown in the following figure.

¥ Peripheral M a
Lx 8 Ly Lx O
Left Above -
Right ﬂﬂ! An axis cannot appear more than Dnce.l

5.3.4. Symbolic position graph for peripheral

Target element: a movable peripheral defined in a resource

23



Right click on a target element, select New Representation and choose the corresponding Symbolic
positions for the target element.

4 [ tutorial.machine
@b Machine tutorial
4 & Resource Robot
W Peripheral C
- | Peripheral A

[

. 8 Peripheral T New Representation » | & Axis positions for RobotM
. 11 Peripheral T Control.. &  Symbaolic positions for Robot.M
. B tutorial.setting & Motion profile settings for Robot.M
. Export representations as imaages F  Phvsical lncation settinns for Rohot.M

The symbolic position graph for the target element includes specific information about profiles and
settling on the paths.

Layout of existing symbolic position graphs will be reset to default layout. As

’ manual layout of these diagrams may require extra time and labor, it may not be
wise to upgrade to the latest release of LSAT for existing symbolic position
specifications.
slow
l [X] l
Abevettl Above Right
X.Left .
o -
normal norfal
slow
[
Below_Left Below_Right
X.left [¥] X.Right

The symbolic positions are shown as compartments. The axis positions corresponding to a symbolic
position are shown inside the respective compartment.

The full mesh paths are shown as gray vertical rectangles. The single-headed arrows between
symbolic positions represent unidirectional paths, whereas double-headed arrows represent
bidirectional paths. If a symbolic position is a part of a full mesh path, then there is also an arrow
between the symbolic position and the full mesh path.

The labels in the center of paths represent motion profiles. Whereas, the labels at the end of paths
represent settling.

Adding/deleting motion profiles

To add a new motion profile to a peripheral, click on the empty canvas. As a result, properties
editor will appear at the bottom. Enter the name of the motion profile without a white space in the
field Add a motion profile, as shown in the following figure, and hit Enter.
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General ~ Motion Profiles
Semantic
Behaviors

EEEEEE | Available Profiles @ |
Documentation narma Delete Profile

= slow
Rulers & Grid

Add a motion profile @

Appearance

The available profiles are visible in the Available Profiles field. To delete a profile, select it and press
Delete Profile on the right side.

Adding/deleting symbolic positions

To create a new symbolic position, select the respective tool from the Symbolic Positions Editor
Tools palette on the right side, and then click on the canvas. The name of the symbolic position can
be typed directly while selecting the newly created symbolic position. Alternatively, the name can
also be typed in the properties editor at the bottom, as shown in the following figure.

I Properties 2

= Symbolic Position Below_Left

[
Semantic Property Value
Style 4 Symbolic Position Below_Left

Name '= Below_Left

A arance
L Source References

Target References “ Path Target Reference Below_Left

To delete a symbolic position, select it and press Delete.

Adding/deleting axis positions

The axis positions can be added to a symbolic position compartment by selecting the respective tool
and selecting the symbolic position compartment. The name of the axis position can be typed
directly in the format Axis.Position (same as textual representation). Alternatively, the name can
also be typed in the properties editor at the bottom, as shown in the following figure. Here, Key
represents an axis and Value represents a position. To delete a axis position, select it and press
Delete.

Semantic Property Value
Style 4 machine.impl.AxisImpl@7af33753 (name: X, unit mm) -> machine.impl.Position
- Key 2 Axis X
M Value Position Right
o The typed axis position name cannot be entered if either of the typed axis or
position does not exist.

Double clicking a symbolic position opens its textual representation allowing to
O specify the axis positions. Pressing Ctrl+Enter in the text editor will save the
changes and pressing Escape will cancel them.
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Above Right Above_Right (XRight, Y.Above) =

1 X.Right
Y.A.bm:ne =
4 I
normall
Adding/deleting paths

Uni/bidirectional paths between two symbolic positions can be added by selecting the respective
tool and clicking the symbolic positions. To add a symbolic position to a full mesh path, select the
Full Mesh Target tool, and then click the full mesh path and the symbolic position. To delete a path,
select it and press Delete.

A settling to a unidirectional path can be added in the properties editor by selecting the path, as
shown in the figure below.

~ Settling
Assign a settling (%) B
Current settlings (@ v
Delete Settling

In the Assign a settling field, a settling can be selected for a path. The settlings currently assigned to
a path are visible in the Current settlings field. To remove a settling from a path, first select the path
and then select the settling in the Current settlings field and press Delete Settling on the right side.

In bidirectional paths, we can add two settlings, i.e., one settling for each connected symbolic
position. A settling to a bidirectional path can be added in the properties editor by selecting the
path, and then assigning a settling at each connected symbolic position, as shown in the figure
below.

~ Settlings
Assign a settling at the location: Above_Left 3 E]

Current settlings at the location: Above_Left @ X
Delete Settling

Assign a settling at the location: Above_Right (%) E]

Current settlings at the location: Above_Right 3
Delete Settling

The settlings currently assigned to a path at a symbolic position are visible in the Current settlings
field. To remove a settling from a path, first select the path and then select the settling in the
Current settlings field and press Delete Settling on the right side.
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Assigning existing motion profiles to a path

To add a motion profile to a path, choose one of the options below:

Option I
* Select the path by left clicking on it.

* Select the General tab.
* Scroll down to the Motion Profiles section.
* Select your the profile you want to add from the Available profiles list.
* Press Add to path.
General Current settlings at the location: AT COND ()
Semantic Delete Settling
Style
Appearance
~ Motion Profiles
Profiles (7) 3 Available Profiles
norma Remove slow Add to path
Option II
* Select the motion profile from the diagram by left clicking on it.
* Press F2 to enable direct editing.
* Add a comma after the existing profile and write the name of the profile you want to add, e.g
normal, slow .Please note slow should have been initialized earlier.
» Save your diagram. The changes are then saved to the model.
rmal (= Symbolic Posi...
[ symbolic
Position
IFuH Mesh Path
ABOVE_IN ABOVE_COND ABOVE_DRILL
XIN X.COND. X.DRILL @ Axis Position
— e T 74 Unidirectional
normal Path
/* Bidirectional
normal SO normal Path
P |- Full Mesh Target
| normal
AT_IN AT_COND AT_DRILL
"] Problems [ Properties 52 |had ChartView @] Emorlog OF Qutline [ Console < » Interpreter 47 Search M =0
+ Bidirectional Path ABOVE_COND <-> AT_COND profiles normal, slow
General Current settlings at the lacation: AT COND (3
Semantic Delete Settling
Style
Appearance
~ Maotion Profiles
Profiles (3 Available Profiles
:I‘;:’"a' Remove Add to path
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Hiding axis positions/paths

In order to visualize a diagram clearly, it is possible to hide axis positions or paths or both from a
diagram. To hide axis positions, click on the canvas, and then click on the Filter icon on the top tool
bar, and click Axis Positions, as shown in the figure below.

BrBiv|lf|Orwrmct| @@ Q 100% ~|mE

Axis Positions
Paths

slow

X1

Paths from a diagram can also hidden in the same way.

Layout

A symbolic position graph can be layout by right clicking on the canvas and selecting Show Layout
View.

Open »
Edit ¢

Refresh F5
Unsynchronized

G

Export diagram as image

Show/Hide

Select »
Layout »

oo B E g

Reset Origin Ctrl+Home
Validate diagram

Find Ctrl+Alt+Shift+F
Quick search Ctrl+0
il Layout Selection
52 Show Layout View
OCL »

As a result, a new tab named Layout will appear at the bottom. Click on the empty canvas, and then
in the Layout tab, a new Property Layout Algorithm with a Value Activity Diagram will appear.

Properties Problems E§ Layout &2
Property Value
Layout Algorithm '= Activity Diagram

Select Activity Diagram, and double click it or use the button on the right side.

A pop-up will appear showing all pre-defined layout algorithms. In our experience, the ELK Layered
algorithm is most suitable for symbolic position graphs. However, please feel free to explore other
algorithms also.
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& Select Layout Algorithm or Type ﬁ
ELK Layered
4 Force Layer-based algorithm provided by the
ELK Faorce Eclipse Layout Kernel. Arranges as many
ELK Stress edges as possible into one direction by
4 Layered _placing node_s into subsequ_ent layers. T_his
Draw2D Layout (GMF) |mplement_at|on supports dlf‘fe_rent rc_nutlng
styles (straight, orthogonal, splines); if
Bl ayered orthogonal routing is selected, arbitrary port
4 Tree constraints are respected, thus enabling the
ELK Mr. Tree layout of block diagrams such as
4 WLSAT actor-oriented models or circuit schematics.
Activity Diagram Furthermore, full layout of compound graphs
4 Other with cross-hierarchy edges is supported when
Box Layout (ELK) ;tgjerlespectwe option is activated on the top
Fixed Layout (ELK) '
Randomizer (ELK)
OK ] [ Cancel

e 4

Select an algorithm and press OK. Afterwards, apply the automatic layout by right clicking on the
canvas and selecting Layout Selection from the context menu, or use the button from the toolbar

&.

Validation

Each symbolic position must have a unique name. To validate this property, right click on the
canvas and click Validate diagram. If any symbolic positions do not have unique names, a red error
sign will appear on those symbolic positions, as shown in the following figure.

slow
{ ™
y
Above_Lef] Al _Rigﬁ
. Y.Above
nofmal
slow
[Y
Below_Lef| Above_Rigﬁ
Xleft Y] X .Right |£9 Symbolic positions must have a unigue name.i

To quickly fix this error, a quick fix is available. Go to the Problems tab on bottom and right click on
the error message and select Quick Fix, as shown in the figure below.

29



4 B Errors (2 items)
& Symbolic positions must have a unigque name.

| A Symbolic positions must have a unigue name.

il Layout Selection

52 Show Layout View

o= Goto

Copy Ctri+C

® Delete Delete
Select All Ctrl+A
Show In »
Quick Fix Ctrl+1
Properties Alt+Enter

Then select the Change name and press Finish.

" & Quick Fix EET)

Quick Fix ]

Select the fix for 'Symbolic positions must have a unique name.', -

Select a fix;

Change name

Problems:
Resource £ Location Select All
@ representations.aird Symbolic positions f...
Deselect All
@ Finsh || Cancel

As a result _new will be added at the end of the name of the symbolic position.
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slow

l ] l

(AlsuetlEl Above Right
Y.Abang normal
normal
slow
Y
Below Left, Above Right_new
X.Left ['Y] X.Right

5.3.5. Motion profile settings table for peripheral

Target element: a movable peripheral defined in a resource.

Right click on a target element, select New Representation and choose the corresponding motion
profile for the target element.

Motion profile settings data is from the first setting file in the project directory.

Column specifies profile names and row represents one axis. Each row contains sub rows to specify
VAJs for an axis.

& Motion profile settings for Robot.M 33
4 MNormal < Slow

a X
<= W [mfs] 1 05
<= A [mfs"2] 1 05
<= 1 [m/fs"3] 05
a =¥
<= W [mfs] 1.0 0.5
<= A [m/="2] 1.0 0.5
<= | [mys"3] 0.5

5.3.6. Physical location settings table for peripheral
Target element: a movable peripheral defined in a resource.

Right click on a target element, select New Representation and choose the corresponding physical
location settings for the target element.

The same to motion profile settings table, the physical location settings data is also from the first
setting file in the project directory.

In the table, each column represents one symbolic position for the target element. Each row
represents its axes and the physical location values (min, default, and max) are shown on the sub
rows.
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B& Physical location settings for Robot.M (3
4= Above_left < AboveRight < Below_Left < Below_Right

a & X[mm] Left Right Left Right
< min  -100 -100
< default -150 300.0 =150 300.0
4 max -200 -200
4 @ ¥[mm] Above Above Below_Left Below_Right
< min
< default 150.0 150.0 -160.0 -130.0
<4 max

5.3.7. Activity diagram

Target element: an activity defined in an activity specification

Right click on a target element, select New Representation and choose the corresponding activity
for the target element.

S e e ETE

It shows an activity diagram with an action flow. Green swim-lanes represent resources and their
peripherals, gray blocks represent either claiming a resource or releasing a resource and brown
blocks represent actions for peripherals. If an action is specified to be scheduled As Late As Possible
(ALAP), then an icon with an arrow pointing down is shown.

The generated activity diagram (probably) needs some layout to be done, but an automated default
layout is applied. The initial layout is not optimal yet, therefore it is wise to apply the automatic
layout once the Activity diagram is visible, using the tip below.

(r') To (re)apply the automatic layout, select Layout Selection from the context menu
- on the canvas, or use the button from the toolbar &

(r) This viewer can also be used to edit the activity by using the palette.
w
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| & D
[ ctaim | W ZR @ DL

Jﬁ

Al Move to UP A on

ST ENT B
l l

A3 Move to Ad: off
DOWN

relegse

Adding a new action

Action details
Provide the details for the action to add

MName: || |

Action:

® Move to: | Symbolic Position UP v|

Move type: | Point-to-point (stop at target position) \/|

Speed Profile: | Profile nermal v|

Scheduling type: | As Soon As Possible (ASAP) “]

® < Back Mext > Cancel

1. Select Action from the Palette at the right side of the editor.

2. Left click somewhere in the green swim-lane of a peripheral. A popup window as the one above
will show up.

3. Provide a name for the action.

4. Use the radio button to select the type of action you want to create. If the action is of type Move,
then you must also specify if it is point-to-point (stop at target position) or on-the-fly (don’t stop
at target position) and the speed profile to use.

5. Select the scheduling type - As soon as possible (ASAP) or As late as possible (ALAP)
6. Click Finish.

7. New action illustrates an example. In this case, the new action is A7.
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| & Drilt

claim T kit ol
Al: Move passing UP A2:on

A3: Move to DOWN Ad: off

AT: Move
to UP
ALAP

Figure 6. New action

Modifying the properties of an existing action

1. Select the action you would like to modify from the activity diagram.
2. Select the Properties tab in Eclipse. It is usually located below the diagram.

3. You should now have access to a menu that looks like the image below.

(r') You can use the Properties view to change the scheduling type of an action from
- ASAP to ALAP or vice versa.

5.4. Location of Generated Graphs

The generated graphs are located inside its target element. By unfolding the element from the
Model Explorer, the generated graphs will appear.
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4 ,5' tutorial.activity
4 4 Activity Set
a i< Activity MoveRobot
&5 MoveRobot Activity
4 Claim C
4 Release R
<4 Move Al
<= Simple Action A2
<= Simple Action A3
<4 Move Ad
<= Sync Bar 51
<= Sync Bar 52
» 4 EdgeC-> Al -» A2-»5]1->A3-»52->R
: 4 EdgeSl-> Ad-» 52
<4 Location Prerequisite

<+ Import tutorial. machine

=] tutonial.cif
> ,5' tutorial.dispatching
4 ,5' tutorial.machine
4 <4 Machine Tutorial
4 <» Resource Robot
<= Peripheral C
4 <= Peripheral M
& Symbolic positions for Robot.M
B Motion profile settings for Robot.M
B Physical location settings for Robot.M

w < Axis Positinns Man Fntre
All the graphs can also be found under the “representations.aird” file.

4 ¥ tutorial
=i Project Dependencies

4 14| representations.aird:

4 +£ Activity Diagram
4 5 Activity
& MoveRobot Activity
4 +£ Physical Settings
4 [ MotionSettings
B Motion profile settings for Robot.M
4 [ PhysicalPositions
B Physical location settings for Robot.M
4 +£ Symbolic Position
4 & PeripheralSymbelicPositions
& Symbolic positions for Robot.M

5.5. Navigation among graphs

In graphical viewer, if one semantic element can be generated more than one graph, these graphs
can be navigated. Navigation only happens when the semantic element is shown as a
container/block in a source graph. Since there is no container concept in table, there is no
navigation starting from a table view. Besides, navigations also request the target graphs have
already been generated.

5.5.1. Navigate from activity diagram

A peripheral is represented as a write block in an activity diagram. Some white blocks contain a
small graph icon & at right bottom corner. It means there are other graphs can be generated for
the semantic element of this block.

Right click on the write block, open with a desired graph. Movable peripherals can produce five
types of graphs: axis position graph, symbolic position graph, motion profile settings table, physical
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location settings table and physical location overview table.

& Robot
|—CT_%JE" Y " Je

Al Move to null

""-—__“—~\_‘
AZ2: unclamp
Open b | & Axis positions for Robot.M
Edit R & Symbolic positions for RobotM
— B Motion profile settings for RobotM
Show/Hide * | B Physical location settings for RobotM
o5 Layout » | B Physical location overview for Robot.M
|: Reset Origin Ctrl+Home
Format r
il Layout Selection
52 Show Layout View
: OCL ¢

release ]

o

5.5.2. Navigate from axis position graph

It is the same as navigation from activity diagram. Right click the container which has a small graph
icon and open with a desired graph. From a axis position graph, it is possible to navigate to
symbolic position graph, motion profile settings table, physical location settings table and physical
location overview table.

W Peripheral M

Ex p R Open » | & Symbolic positions for RobotM
; Le_ft ADoun Edit \ = Moti_on proﬁlt_a settings for RobotM
+| Right s & Physical location settings for Robot.M
" Refresh F5 |E Physical location overview for Robot.M

Unsynchronized

(@ Exportdiagram asimage

= Show/Hide

% Select 3

o8 Layout ’
Reset Origin Ctrl+Home

Validate diagram

Find Ctrl+ Alt+Shift+F
Quick search Ctrl+0
Layout Selection

Show Layout View

OCL r

&l B
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5.5.3. Navigate from symbolic position graph

Right click the container which has a small graph icon and open with a desired graph. From a
symbolic position graph, it is possible to navigate to axis position graph, motion profile settings

table, physical location settings table and physical location overview table.

Below_Left

il

Below_Rig
X.Right

slowe

ormg

hbove_Righ'lJ

X.Right
Y.Above

&

RCal |

&l &

Open
Edit

Refresh

Unsynchronized

Export diagram as image
Show/Hide

Select

Layout

Reset Origin

Validate diagram

Find

Quick search
Layout Selection
Show Layout View
OCL

F5

Ctrl+Home

Ctrl+Alt+Shift+F
Ctrl+0O

3

3

B B B e

Axis positions for Robot.M

Motion profile settings for Robot.M
Physical location settings for RobotM
Physical location overview for Robot.M
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Chapter 6. Schedule Activities

6.1. Scheduling & Configurations

o Scheduling an activity sequence requires a fully specified system. See section
Logistics Specification for more information on creating this specification.

Scheduling an activity sequence generates a Gantt chart that represents the system execution in
time. Within an activity sequence one or more activities can be included. These activities will be
scheduled as parallel as possible adhering to the claim/release strategy. If activities cannot be
scheduled in parallel the order of this section is applied. An activity typically starts with claiming a
Resource, hence this activity can only start if it predecessor activity has released this Resource.

Optionally an offset can be defined for an activity sequence. The scheduler will ensure that these
activities will not be started before the offset time.

The scheduling of activity sequences is configured via the Run Configurations window. To access
this window either right click a dispatching file and navigate to Run As - Run Configurations... or use
the dropdown from the green play button in the toolbar on top.

FrO~ Qv Fv Givilvr

“% 1 New_configuration 5
——— [# 2 generatePaths -

—_ Run As ' I,:
Run Configurations...

Organize Favorites...

Available scheduling configurations show in the list on the left side of the Run Configurations
window below the entry for Timing Analysis.

© Run Configurations X

Create, manage, and run configurations @

Narme: | New_ ]

Timing Analysis . =] Common
Activity Dispatching

[ jtutorialtutorial dispatching

Show
Ono Gantt chart

@ Gantt chart

O Gantt chart with critical path

(O Gantt chart using stochastic impact analysis
Options

ch || (] Show web animation

[[]Remove dependencies for claims and releases

Revert Apply

<
Filter matched 13 of 13 items

) Run Close

(r) A new configuration can be created by using the New Launch Configuration button

- |

A Timing Analysis run configuration consist of the following elements:

* Name Allows the user to identify the configuration for future usage.

» Activity Dispatching Each configuration refers to one particular dispatching file. This is a
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required field.
* Show
> no Gantt chart No Gantt chart is generated

- Gantt chart A Gantt chart is generated and is shown on-screen. The timing of the Gantt
chart is based on fixed timing settings and default values. The coloring is based on
correspondence between Activities and Resources, see below for a more detailed
explanation.

- Gantt chart with critical path A critical path analysis of the schedule is made, based on
fixed timing settings and default values, and is represented in a Gantt chart. The coloring is
based on the outcome of the critical path analysis. See below for an explanation of the
coloring scheme.

- Gantt chart using stochastic impact analysis Based on fixed timing and default values a
Gantt chart is generated. The coloring is based on the probability that a task will be on the
critical path given the specified timing distributions. In order to determine this probability
200 samples are drawn. For each sample a schedule is determined and a critical path
analysis is performed. See below for an explanation of the coloring scheme.

* Options

- Show web animation The scheduling produces skeleton files for Javascript/Paperscript
based 2D animations. The default animation shows colored dots and by modifying the
skeletons arbitrary animations can be produced. If the configuration also generates a Gantt
chart an timing indicator is shown on the Gantt chart that is synchronized with the timing of
the animation. The Javascript files are located at analysis/scheduled/animated.

- Remove dependencies for claims and releases Before calculating the critical path the
dependencies relating to claims and releases are cut short. As a result claims and releases
are not included in the dependency graph and are thus removed from the critical path while
preserving the net effective dependencies between actions. NB The claims and actions
themselves are not removed from the schedule nor is the timing of the schedule
influenced by this option.

6.2. Gantt Charts

The Gantt chart shows a resource on the Y-axis for every Peripheral which participates in the
activity sequence. The X-axis shows the relative time in seconds. Each resource in the Gantt chart
shows a low bar and a high bar:

Low bar Represents the claiming of a Resource in the Machine by an Activity. This bar is
replicated for all Peripherals in the claimed Resource.

High Bar  Represents an action that is performed by a Peripheral. An action can be either a
move or an atomic action.

The arrows represent the dependencies between the tasks.
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When a Gantt chart is generated, at least two files have been created in the project
folder analysis/scheduled (i.e. the Gantt file <file>.etf and a configuration file

o Scheduling Config.txt). The file name of the etf file is derived from the file name of
the dispatching file that is scheduled. The Gantt file is automatically opened in an
editor showing the Gantt chart.

& ws-runtime - Modeling - tutorial/analysis/scheduled/tutorial.etf - Logistics Specification and Analysis Tool - m} X

File Edit Mavigate Search Project Run Window Help

(w4 iR AT D ARl @M e W G~ 7 ~ v Lo = :§’|&.-U&J Ly
B Model Explorer &2 = B T tutorial.etf =2 = 8

type filter text

~ & tutorial
=\ Project Dependencies
(= analysis
[ representations.aird
1 wiarial.activity
[ tutorial.cif
* tutorial.dispatching
[ tutarialmachine
[* tutorial setting

|42; unclamp | A3 clamp
Robotl.C 1

Resource

A1 move to Balow_Right Ad: move to Above_Right Al move to Below_Right A4 move to Above_Right
5= Qutline & =0 Rebot1M {
An outline is not available.
0,000 L.000 2.000 3,000 4,000 5,000 6,000 7.000 2.000 9.000 10,000 11000
Time in sec.
[4] »
[ Properties '*! Problems B ESI Trace Properties & =]
Property Value A~
Context ClaimContext
Start Time 0.000 sec,
Stop Time 2778 sec.
Duration 2.778 sec.
Claim Type ClaimAmountOffset
Amount 80.0 v
410Mofsi2m @ i
(2 . . . . .
The ESI Trace Properties view shows detailed information about the selected bar.

6.2.1. Gantt chart

In case of a Gantt chart without critical path analysis the color of the low bars represent the Activity
that holds the claim. Additionally all actions, the high bars, of the same Resource are colored
equally. The black arrows indicate the dependencies as specified in the Activity and the gray arrows
indicate the dependencies between Activities as derived from the claim/release strategy.

Scheduling the actions in the activities

An action can be scheduled using two types of algorithms: As Soon As Possible (ASAP) or As Late As
Possible (ALAP). The default algorithm for all actions is ASAP, unless specified otherwise as
described in Logistics Specification. As mentioned previously, resource claiming or releasing are
always ASAP by design.

ASAP executes each action on a resource as soon as the resource is available, and all preceding
actions have finished.
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ALAP executes each action on a resource as late as possible. You can see the difference between the
two schedules illustrated below.

S ws-runtime - Modeling - tutorial/analysis/scheduled/tutorial.etf - Logistics Specification and Analysis Teol — m} *
File Edit Navigate Search Project Run Window Help
N Ei=pdvR A T+Er uEa® + Qi v I etsow oy
B Model Explorer &= = B T wtorial.etf 2
type filter text
~ I tutorial
=4 Project Dependencies
= analysis . 4
. + unckam) A3
[ representations.aird e " e
" N _ Raobotl.C {
= tutorialactivity
¥ tutorial.cif
¥ tutorial.dispatching
21 tutarial machine
[ tutorial setting
2
=
2
3
o
Al move to Below_Right Ad: move to Above_Right Al move to Below_Right Ad: move to Above_Right
Sz Qutline &2 =0 Robat1M {
An outline is not available.
0,000 1.000 2,000 3.000 4,000 5,000 6,000 7.000 2,000 2,000 10,000 11000
Time in sec.
[l »
[ Properties ¥ Problems B ESI Trace Properties & = a
Property Value ~
Context ClaimContext
Start Time 0.000 sec.
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Figure 7. ASAP scheduling example for Action A3
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> @ tutorialif 2
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Figure 8. ALAP scheduling example for Action A3
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6.2.2. Gantt chart with critical path

In project management the critical path is defined as “the sequence of scheduled activities that
determines the duration of the project.” The same applies for the calculated schedule as visualized
in the Gantt chart.

When a critical path analysis has been performed the actions and dependencies are either colored
red or grey. Red indicates an action or dependency is on the critical path of the schedule. The low
bars can be dark red, light red or grey. Dark red indicates both claim and release are on the critical
path. Light red indicates either claim or release, but not both, are on the critical path. Grey is used
to indicate neither claim or release are on the critical path.

Robot1.C

Resource

Robot1M {

6.2.3. Gantt chart using stochastic impact analysis

The actions in the Gantt chart of the stochastic impact analysis are colored based on the probability
that the action is on the critical path taking into account the specified timing distributions. A dark
bluish grey indicates that the action will never be on the critical path, bright red indicates the
action is always on the critical path. Intermediate colors are used to indicate intermediate
probabilities. Tasks can be selected by using the mouse and the Properties window shows the
property Critical that displays the probability that the selected task is on the critical path.

Resource
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6.2.4. Filtering

By default the Gantt chart will hide all superfluous information. To show all information in the

Gantt chart use the ESI Trace toolbar to Clear all filters. Now all dependencies a drawn and also the
dispatching offset is visualized.

Or For more information about the possibilities in the ESI Trace viewer, see the
- TRACE user manual in the Eclipse help.
S ws-runtime - Modeling - tutorial/analysis/scheduled/tutorial.etf - Logistics Specification and Analysis Tool — ] *
g " g P iy’
File Edit Navigate Search Project Run Window Help
= @ RA Y > T ARk O MR R U~iPrifi~F oD~ [Quick Access] || 2| w Ry & [
B Model Explorer 2 = 8 T wtorialetf 2 =0
type filter text ‘
v & tutorial
=4 Project Dependencies . . Dispatch at 6.00
. Dispatch at 6.00
= analysis
[#] representations.aird
* wrarialactivity
M tutorial.cif
1M tutorial.dispatching
21 tutorial.machine
[ tutorial setting
@
g A2: unclamp  A3: damp 12: unclame|  A3: damp
32 Aobotl.C
(4
-4
o= Outline 22 = 0
An outling s not available. AL: move to Below_Right A4: move to Above_Richt AL: move to Below_Right Ad: move o Above_Right
Robot1.m
0,000 L000 2,000 2.000 4,000 5.000 6,000 7.000 2.000 2,000 10,000 11000 12,000
Time in sec.
[ Properties !*! Problems Bk ESI Trace Properties & = 8
Property Value ~
Context ClaimContext
Start Time 0.000 sec,
Stop Time 2,778 sec.
Duration 2.778 sec.
Claim Type ClaimAmountOffset
Amount 800 v
RMofs2M W {a
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Chapter 7. Throughput per Resource Editor

The throughput per resource editor helps to identify where the specification can be optimized for
throughput performance of the system.

As the specification is partitioned in multiple files (i.e. dispatching, settings, schedule, etc.) this
makes it rather difficult to identify where the specification can be optimized for throughput. For
this a new view has been designed which provides an overview of the most critical information
w.r.t. throughput optimization for a specific activity dispatching sequence.

For each resource in the specification a tab page is available in the editor. The tab page shows an
ordered table with all actions that are relevant for its resource. More information about the table
content can be found in section The Resource Actions Table. The Outline view shows an overview of
the throughput per resource and the throughput of the total activity dispatching sequence, for more
information see section The Outline View.

7.1. Opening the Throughput per Resource Editor

The Throughput per Resource editor shows information for a specific activity dispatching
sequence. For this reason the editor can be opened by means of the context menu of a particular
dispatching file. The use of the context menu is needed as by default the Dispatching Editor is
opened when double-clicking a dispatching file. To open the Throughput per Resource editor right-
click a dispatching file in the Model Explorer view and select Open With — Throughput per Resource
Editor from the context menu.

B Model Explorer 52 E| ¥ = B
type filter text
4 i Tutorial
4 7 specification
|Z| tutorial_tp.activity
|Z| tutorial_tp.dispatching
= tutorial.activity

=l tutorial.dispatchins

|5 tutorial.machin New b
|5§, tutnrial.setting Open ;3
=l tutorial TP1
Open With b | = Dispatching Editor
Throughput per Resource Editor

[ Copy Ctrl+C

Eclipse remembers the last editor used to open a file. When double-clicking the file

o this editor will be used again to open the file. The Open With context should be
used to open the file using another editor.

7.2. The Resource Actions Table

The resource actions table contains a row for every action in the activity dispatching sequence that
is relevant for the resource. The rows are ordered as such that their actions are ordered in
topological order w.r.t. the activity dispatching sequence. Topological ordering basically means that
an action will never be listed before all actions required to be executed prior to the action. So this
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doesn’t guarantee that two succeeding actions in the table are executed in sequence as they might
be executed in parallel. For more information on how the action sequence is determined please see
section Calculating the Throughput per Resource.

In general a table cell will be gray when its information is not applicable for the action at that table
row. When needed the data in the table either can be refreshed or reloaded.

Refreshing the data - by means of the «* toolbar button - will update all data in the resource actions
table and Outline view reflecting the current state of the editor including already made changes.

Reloading the data - by means of the & toolbar button - will discard all made changes and reload
the specification models. This action can be used to reload changes in the specification which are
made outside the Throughput per Resource editor.

The Throughput per Resource editor will not detect added/deleted resources, axes
A and setpoints. When these are modified the Throughput per Resource editor needs
to be closed and re-opened again.

The table contains the following columns:

Peripheral The fully qualified name (format <Resource Name>.<Peripheral Name>) of
the peripheral performing the action.

Action The fully qualified name (format <Activity Name>.<Action Name>) of the
action.

Name / From Either the name of the peripheral action or the start position of the move.

To The end position for the move.

Settling The axes that require settling for the move.

0ld <Axis> The start location per axis for the move.

New <Axis> The end location per axis for the move. An icon 4 or # indicates that the

axis is adjusted as part of the move. The @ icon in the column header
indicates that the values in this column may be edited.

Profile The motion profile name for the move. The @ icon in the column header
indicates that the values in this column may be edited.

<Setpoint>time  For every setpoint, the minimum time needed to adjust the setpoint using
its axis motion profiles. In other words, the time needed to adjust the
setpoint conforming to its motion profile, not taking into account the
adjustment of other setpoints, thus no stretching will be applied.
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Time The time needed to perform the action. An icon ¥ indicates that the action
is on the critical path of the resource. For more information see section
Calculating the Throughput per Resource and section Gantt chart with
critical path. The @ icon in the column header indicates that the values in
this column may be edited. Do note though that this only applies for the
times of peripheral actions and not for moves.

5% Outline 22

Resource Makespan [sec] MNo. It.. lteration Mak.. Through.

Robot1 11.803050 2 5901525

= B [@ tutorial dispatching

% Resource Robot1
6100 Peripheral
Robot1M
Robot1.C
Robot1M
Robot1.C
Robot1M
Robot1.C
Robot1M
Robot1.C

<
% Robot1

7.3. The Outline View

The image in the previous section also shows the Outline view. This view shows a table with an
overview of the throughput per resource and - in the last row - the throughput for the total activity
dispatching sequence. For more information on how the throughput is calculated for a resource,
please see section Calculating the Throughput per Resource.

Action

MoveRobot Al
MoveRobot.A2
MoveRobot A4
MoveRobot.A3
MoveRobotAl
MoveRobotA2
MoveRobot A4
MoveRobot.A3

The table contains the following columns:

Resource

Makespan

No. Iterations

Iteration Makespan

Throughput

The resource for which the throughput is calculated.

Name / From
Above_Right
unclamp
Below_Right
clamp
Above_Right
unclamp
Below_Right
clamp

To
Below_Right

Above_Right

Below_Right

Abave _Right

Settling
¥

odXx
200.0

300.0

300.0

300.0

oldY [ NewX

150.0

-150.0

150.0

-150.0

3000 &

3000 4@

3000 &

3000 4

=B

L
¥ NewY @ Profile
-150.0 slow
1500 normal

-1500 slow

1500 normal

The total time needed to perform all resource actions in the activity

dispatching sequence.

The number of iterations for this resource in the activity dispatching
sequence, for more information see section Specifying the number of

iterations.

The total time needed to perform exactly 1 iteration in the activity

dispatching sequence.

The theoretical maximum number of iterations per hour that this
resource is capable of executing.

7.4. Calculating the Throughput per Resource

This section provides some background information on what is meant by calculating the

throughput per resource.

Though the systems throughput performance is determined by the full orchestration of all actions
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for all resources and peripherals in the system, sometimes it is good to know which resource is
most critical in this orchestration. When calculating the throughput per resource the theoretical
maximum throughput of the resource is calculated as if no actions of other resources are limiting
its throughput, with the exemption of all actions in the 'entangled’ section of an activity.

The entangled section of an activity

With the entangled section of an activity the section is meant in which multiple resources are
working together in harmony, most likely to transfer a product from one location to another. Maybe
this can be explained a bit easier by use of the following example. The figure below shows the
schedule of an activity dispatching sequence with an overlay that illustrates the pre, post and
entangled sections of an activity. The activity 'Robotl_GiveTo_Robot2' is repeated twice in the
dispatching.

(@] tutorial_2resources.dispatching T m:o ial, rzs"o rcgeﬁ =2 = A8

Pre-Robot1 ; Post-Robot1Pre-Robot1

Robot1.C

Robotl.M

Resource

F
Pre-Robot2 Post-Robot2Pre-Robot2 Post-Robot2

Robot2.C
|

Iteration 1 Iteration 2

Robot2.M Entangled Entangled

0.000 1.000 2,000 3.000 4.000 5.000 6.000 7.000 8.000 9,000 10.000 11.000 12.000 12,000
Time in sec,

I»]

Robot2 Waiting

In the entangled section Robot2 first needs to clamp before Robotl is allowed to unclamp. This
causes a gap in the schedule of Robot1 as illustrated by the blue rectangles. As these gaps are within
the entangled section, they are kept in the schedule when calculating the throughput for Robot1.

Additionally to gaps in the entangled section, Robot2 also has gaps in the schedule in its prepare
section, as illustrated by the yellow rectangles in the schedule. These gaps are caused by Robotl
delaying Robot2. For calculating the throughput for Robot2 the pre and post sections of Robot1 will
be omitted and a schedule will be used as illustrated in the following image.
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(2] tutorial_Zressurces.dispatching 1' tutorial_Zresources.etf m-

Robot1.C

Pre-Robot2

E Robot2.C

Iteration 1
Robot2M Entangled

Post—RobotZPre-Robth

lteration 2
Entangled

Post—Robot2

0,000
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Chapter 8. Generating Optimal Activity
Dispatching Sequence

This feature generates an optimal activity dispatching sequence for a given activity specification.

As an activity file may contain multiple activities, it is difficult to generate an optimal sequence of
activities in the activity dispatching file by hand. Therefore, a new feature has been designed which
automatically generates an optimal activity dispatching sequence w.r.t. makespan/throughput.

The requirements of a system are synthesized as a supervisory controller using a modeling
language termed Compositional Interchange Format (CIF). The documentation and tutorials for CIF
can be found at http://cif.se.wth.tue.nl/index.html.

8.1. Generating Dispatching File

Target element: an activity specification

Right click on a target element, select Generate Dispatching File (throughput) for generating an
optimal activity dispatching sequence w.r.t. throughput.

% Model Explorer &3 = O

- &

type filter text

w & tutarial
=i Project Dependencies
= analysis
|| representations.aird
1 weorial.activity

[ tutorial.cif New >
[ wrorial.dispau Open 3
[ tutorial.machir Open With y
[* tutorial.setting
£ Copy Crl+C
Paste Ctri+V
K Delete Delete
Move...
Rename... F2
g Import..
fa  Export...
Refresh F5
Validate

#s Generate Max-Plus Specification
#a Generate Dispatching File (throughput)
Bs Generate Dispatching File (makespan)
Run As »

For generating an optimal activity dispatching sequence w.r.t. makespan, select Generate
Dispatching File (makespan).
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& Model Explorer & =0

type filter text

~ 2 tutorial
B\ Project Dependencies

» = analysis
» [ representations.aird
+ M tutorial.activi~-
> [ tutorial.cif
» [ witorial.disp: Open F3
> [ tutorial.mack Open With ?
> [ tutorial.settir B

New »

Copy Crl+C
Paste Cirl+V
*K Delete Delete
Move...

Rename.. F2

Impart..
Export.

Refresh FS

Validate

Generate Max-Plus Specification

Generate Dispatching File (throughput)

Generate Dispatching File (makespan)

Run As »

EE

ar T

Select relevant CIF specification file.

£ Select cif specification le
Select cif specification to attach to activity specification
4 & tutorial
|ls tutorial.cif
OK
® oK | [ Cancel l

The dispatching file showing the optimal activity dispatching sequence is generated in the result
folder.

4 & tutorial
=k Project Dependencies
4 (= result
» | tutorial_makespan.dispatching|
» | 2 tutorial_throughput.dispatching|
representations.aird
v B tutorial.activity
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8.2. Viewing Optimum Makespan/Throughput

The optimum makespan/throughput can be seen in the Error Log view. The Error Log view can be
opened by clicking Window in the toolbar on top and Show View — Error Log.

Window | Help

u Mew Window fich HiQ v @ wi@E[MiE ~ 5
Editor (3
Appearance k
Show View r| Gz Applications
Perspective v| B Console Alt+Shift+Q, C

o , <] Error Log Alt+Shift+0), L

AEaET % Package Explorer  Alt«Shift+Q, P

|*. Problems [ Properties s Chart View @ Error Log 1 52 Layout

Workspace Log

Plug-in
nl.esilsatbranding

Message
i Optimum Throughput: 0.17232169013113682

For calculating the optimum throughput, the CIF file must contain a cycle.

F

£ Convert activity specification to dispatching file

=)

&% Converting activity specification to dispatching file failed:

k.

See Error Log for details.

= Cannot compute the optimum throughput. Input CIF file does not contain a cycle.

For calculating the optimum makespan, the CIF file must not contain a cycle.

£ Convert activity specification to dispatching file

~

X4

3

Converting activity specification to dispatching file failed:
Cannot compute the optimum makespan. Input CIF file contains a cycle.

k.

See Error Log for details.

The generated activity dispatching sequence can be scheduled in the form of a
gantt chart. See section Schedule Activities for more information.
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Chapter 9. Conformance Check

Conformance checking functionality is used to check whether traces from log files are able to be
projected to a certain dispatching.

9.1. Add Trace Point

Before conducting a conformance check, trace points are supposed to be added to activity
specifications. Trace points, logged in trace log files, are used to identify the starting and end points
of an event. An example of log file is given below. Each line in a log file contains all the information
of time and a trace point.

By default, log files with an extension trace are supported for conformance
(r) checking. A trace file is line based where each line starts with an instant in UTC
- (i.e. parsed using DateTimeFormatter.ISO_INSTANT), followed by comma-space
and then the trace point.

2011-12-03707:15:30.4549947, TP-0001
2011-12-03707:35:15.4548947, TP-0002
2011-12-03707:35:15.455168Z, TP-0005
2011-12-03707:35:15.455172Z, TP-0006
2011-12-03707:35:15.455429Z, TP-0007
2011-12-03707:35:15.4554347, TP-0008
2011-12-03707:35:15.455588Z, TP-0009
2011-12-03707:35:15.455591Z, TP-0011
2011-12-03707:35:15.455797Z, TP-0010
2011-12-03707:35:15.455805Z, TP-0012
2011-12-03707:35:15.456519Z, TP-0003
2011-12-03707:35:15.456716Z, TP-0004

In the first line, “TP-0001” is the string identifying the trace point in principle which is unique
throughout the entire log files.

Additionally, there must be a trace point specification, which maps a trace point to either a starting
or an end point of a known action. For instance, TP-0001 maps to start claiming Robot. In order to
perform conformance check, trace points are supposed to be added to its related activity
specification surrounding an action definition.
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import "tutorial.machine"

activity MoveRobot {
prerequisites {
Robot1.M at Above_Right
}

actions {

C: ["TP-0001"] claim Robot1 ["TP-0002"] @®

R: ["TP-0003"] release Robot1 ["TP-0004"]

A1: ["TP-0005"] move Robot1.M to Below_Right with speed profile slow ["TP-0006"]

A2: ["TP-0007"] Robot1.C.unclamp ["TP-0008"]

A3: ["TP-0009"] Robot1.C.clamp ["TP-0010"]

Ad: ["TP-0011"] move Robot1.M to Above_Right with speed profile normal ["TP-0012"]
}

action flow{
C->A1 ->A2 -> |51 ->A3 -> [S2 >R
|ST -> A4 -> |S2

@ ["TP-0001"] and ["TP-0002"] represent starting and end points for claiming a Robot.

9.2. Conduct Conformance Check

After adding all the trace points to an activity specification, conformance check can be applied
upon a dispatching file.

0 Dispatching offset is not supported for conformance check currently.

Right click on a dispatching file and select Run Conformance Check.

Run Cenfermance Check

Properties Alt+Enter

Note that in order to obtain a successful conformance check based on the above activity file, the
dispatching file look like:

import "tutorial_tp.activity"

activities {
MoveRobot ("First product")
}

Select trace files to run the conformance check, and Next.
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& Run Conformance Check O *

Select traces g

Select throughput traces to check against the specification

v & Tutarial
= analysis
= result
[5 tutorialtrace

There are several configurations for conformance check.

i B
& Run Conformance Check E‘Eﬂ
Select conformance check options @
Select the options to apply for the conformance test

Activity dispatching
[ Looped activities

Conformance level
) Minimal
@ Claim

(") Dispatching

@ ned> | [ Finish ][ cCancel |

Activity dispatching  Selected, if it activity dispatching occurs multiple times in log files.

Conformance level There are three levels for conformance check.
Minimal - only recognized trace points are kept for conformance
check. It will pass, as long as it find one valid projection.
Claim - based on minimal level, all trace points for the claimed
resources are used for conformance check.
Dispatching - most strict conformance check, it requires all the
recognized trace points in log files are perfectly matched, even before
claiming and after releasing a resource.

Set conformance check options and Finish. The conformance check will be executed.

After the progress is completed, a pop-up will appear to show whether or not it passes the
conformance check.
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i ™Y
& Perform conformance check on specification u

@ The trace(s) conform to the specification

& Problem Qccurred - O ot

I@ '‘ConformanceChecklob’ has encountered a problem.

Conformance check failed, unexpected end of trace, see
petri net for details

OK Details > >

If a conformance check fails, a petrinet file will be generated under the folder analysis/conformance.
It is used to diagnose conformance check failure.

In order to open a graphical view of a Petri Net, a new viewpoint needs to be added to the project.

& Model Viewpoints Selection

type filter 4
4 [ test

@ i

Create Representation

Mew 3

Go Into

- Copy Ctrl+C
b Paste Ctrl+V

& Viewpoints Selection O >

Selected viewpoints

Change viewpoints selection status (see tooltip for details about each viewpoint)

S8 Activities
ﬁ‘gﬁ.naly;is
b Physical settings
d Machine

@
@ If the Analysis viewpoint is not visible, please restart your Eclipse using File »
- Restart.

Navigate to a Petri Net model element to open an existing graphical view or right click it to create a
new one.
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4 @ tuterial_tp.petrinet |
» | 4 Petri Met MoveRobot
Mew Representation b | & Petri Net MoveRobot

Control...

A graphical view is opened.

MoveRobot

TP-0009 TP-0010
P-0005 P-0006 P-0007 p-0008 tau S g tausa 7P-0003 P-0004
\ \ §— p10 |} A3 —= 9 | / \ y O]
—> Al t  p4 —> A2 *  p3 _ : ] R t pl
TP-0011 TP-0012
:
p6 |} Ad — p5

The Petri Net shows how the trace lines are projected upon it.

@

Black Bar - it represents a trace point transition. A green arrow on top indicates this trace point
transition has been passed.

Gray Bar - it represents a transition doesn’t require a trace point check.

Red Bar - it represents an armed transition with a certain trace point is expected. Usually, it is a
place where an error occur.

Yellow Circle - it represents an action as a place.

Gray Circle - it is a place to connect two transitions, if there is no action in between.

Blue Token - it indicates where the conformance check stops.

9.3. Filter Trace Point

Filtering out irrelevant trace points in log files is not required for conformance check. However, it
helps to reconstruct activities manually, especially when the amount of irrelevant trace points is
much more than the relevant ones. Before filtering, activity specification should be inserted with
trace points.

Right click log files and select Filter traces.

[ tutorialtrace

New »
Open F3
Open With »
 Copy Ctrl+C
Paste Ctrl+V
#K Delete Delete
Move...
Rename... F2
a  Import..
g Export..
Refresh F5
*r Filter Trace

Select Activity elements which contain all the relevant trace points and continue with OK.
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il )
& Select activities B

Select activities to filter from trace
a [ test
[ [= analysis
b |E tutorialactivity
4 5 tutorial_tp.activity
4 4 Activity Set
i | 4 Activity MoveRobot |

oK

@ Lo ]I

Cancel l

4

After filtering, selected log files will only keep the trace points which are used in activities.



Chapter 10. Generate Max-Plus Specification

The timing behavior of the activity execution is characterized by two elements, which are:

synchronization

delay

waits for incoming dependencies to finish

duration of execution before completion (fixed timing)

Max-Plus aims to capture the timing behavior of the activity in a matrix. Then, the computation of
the worst-case and best-case throughput/makespan optimization is based on this matrix.

In order to generate it, click on the activity file and select Generate Max-Plus Specification.

-

% Model Explorer
-Ly pe filter text

w 4% tutorial

]

v = "

J21

=\ Project Dependencies

= analysis
= result

=| representations.aird

(¥ tutorial.activity
& tutorial.cif

[ tutorial.dispate
[ tutorial.machir
(2 tutorial.setting

EE

LY
2y

Eo

Mew

Open
DOpen With
Copy

Paste
Delete
Move..,
Rename..

Impaort...
Export...

Refresh

Validate

Generate Max-Plus Specification
Generate Dispatching File (throughput)
Generate Dispatching File (makespan)

F3

Crrl+C
Cirl+V

Delete

F2

F5

(=1

Next, select the respective CIF file. If the CIF file contains cycles,the optimal throughput can be
computed. Modify the CIF file as it is shown below in order to simply include a cycle.
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controllable MoveRobot;
supervisor Tutorial:
location 10:
initial;
edge MoveRobot goto 11;

location 11:
edge MoveRobot goto 10;

end

Now, we are ready to generate the activity dispatching sequence which ensures optimal
maximum/minimum throughput.

& ws-runtime - <Wafer Logistics> - tutorial/result/tutorial_tutorial.mpt - Logistics Specific... — O X
File Edit Navigate Search Project Max Plus Editor Run Window Help
NrGB:@® =d~RATYT~B-mBa@M M= @dB0B: 33X
BrO"QriFriiviv Yy Quick Access| || & | [RIRy & -
B Model Explorer &2 = B @ tutorial_tutorial.mpt = O
% ¥ « @ platform:/resource/tutorial/result/tutorial_tutorial.mpt
|type filter text | ~ % Max Plus Speciication Undo Ctrl+Z
3 tutor » % Matrix MoveRobot Redo Ctrl+Y
~ &= tutorial FoM tutoria|
=4 Project Dependencies - ona . Cut
> & analysis & Copy
- & result Paste
» [ tutorial_makespan.dispatck X Delete
w [ tutorial_tutorial. mpt Validate
) » 4 Max Plus Specification ETEL
: [ representations.aird
> [ tutorial.activity Run As :
[#" tutorial.cif Deb_ug As ?
> [ tutorial.dispatching Profile As g
> B wronal.machine Validate
» [ tutorial.setting Team ?
Compare With 5
€ » | il Problems roperties k& Chart Vi.. "JEmorl Replace With >
i = & Layout Selection
S Outline = =0 Workspace Log " | EL Show Layout View
An noflina iz nnt availahla faay b
Selected Object: platfurm:.fresuurceﬂutunalfresumm?nal_tutorual.mpt Load Resource...
: v’E|| =
Refresh

Calculate maximum throughput
Calculate minimum throughput
Calculate maximum makespan
Calculate minimum makespan

Chomser DPrmeasrtios Wisass

*. Problems [ Properties lad Chart View @)Errorlog 2 [ Layout HE v BERXEF
Workspace Log
type filter text
Message Plug-in Date
i Max plus result: MaximumThroughputResult [throughput=0.17232169013113682, nl.tue.mptmetamodel.editor 2/12/19, 1:05 PM
i Max plus result: MinimumThroughputResult [throughput=0.17232169013113682, nliuemptmetamodel editor 2/12/19, 1:05 PM
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Chapter 11. Generate GraphML from CIF
specification

LSAT also gives you the opportunity to generate a GraphML diagram from a CIF specification. This
feature allows the user to verifying the correctness of the CIF specification.

[ tutor” *
2 tutor
21 tutor
= Open =3

| tute
g tutoy Open With s

New >

= tutor

%tutm B copy Ctrl+C

& tutor - v
B Paste Ctrl+
I tuterial-
13 twilight- Move...
L3 twilight- Rename... F2
L3 twilight-

Delete Delete

Import...
Export...

EE

Refresh FS

Validate

Run As >
Debug As >
Profile As >

)

Design Space Visualization

Acceleo Convert CIF to yEd dizgram |

CIF miscellaneous tools ¥

CIF verification tools

>
CIF implementation taols >
>

CIF synthesis tools

Convert CIF to yEd diagram...

D On O On On Oy
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To do so, execute the following steps:

Right click on the desired file containing the CIF specification.
Select Convert CIF to yEd diagram.. as shown in the figure above.
Select your desired output from the available radio buttons: error, warning, normal or debug.

Press OK.

S A

Two new files should be generated:
a. (name of your cif file).model.graphml

b. (name of your cif file).relations.graphml

For the official documentation on the CIF to yEd transformer, click here.
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Chapter 12. Twilight Manufacturing System:
a showcase

The first step for using LSAT in industry is to decompose the manufacturing system into a plant by
defining resources, peripherals, actions and the respective activities ordering.

In this section, we introduce the Twilight System to show a use case of LSAT in industry. Twilight
refers to a simplification version of a wafer handling sub-system used at ASML. This system is
presented in the figure:

The components of a system are described by resources. Each resource consists of one or many
peripherals.

The behavior of the system is modeled on three levels:

1. Actions: executed by peripherals.

2. Activities: used to describe scenarios of end-to-end deterministic behavior. An activity consists
of a set of actions and dependencies among these actions.

3. Activity sequences: used to describe orderings of activities.
Within the respective system, the Resources are Collision Area (CA), Load Robot (LR), Conditioner
(COND). Each resource contains usually more than one peripherals, for example resource LR is

composed of three peripherals: the R and Z motors and the CL clamp. The motors allow LR to move
within a certain area, whereas the CL clamp allows it to grasp/release a product.

The actions are:

1. Claim and Release resources;

2. Unclamp, Clamp, Moves.

The basic activities are: Condition and Drill, whereas those related to the moving are:
LR _PickFromInput, LR _PickFromCond, LR_PickFromDrill, LR _PutOnCond, LR_PutOnDrill
UR_PickFromCond, UR_PickFromDrill, UR_PutOnCond, UR_PutOnDrill, UR_PutOnOutput.
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The name of the activities can be easily connected to the respective meaning based on figure:
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Based on the dispatching file which specifies the ordering of activities, a feasible schedule can be
generated, which meets the constraints related to the resources and the synchronization/delays.
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As explained in Generating Optimal Activity Dispatching Sequence, this schedule can be optimized
in terms of throughput/makespan based on the information included in the CIF file.
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The figure above shows the ordering of the activities for an optimal throughput.

For an extensive explanation regarding the theory and the examples based on LSAT, please refer to:
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1. Modular Specification and Design Exploration for Flexible Manufacturing Systems, PhD, J.
Bastos

2. Performance Analysis and Optimization of Supervisory Controllers, PhD, B.Sanden
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Chapter 13. Release Notes

The release notes of the Logistics Specification and Analysis Tool (LSAT) are listed below, in reverse
chronological order.

13.1. LSAT v2.0.1

This version only contains bug fixes to repair links to third party products that are used by LSAT.

13.2. LSAT v2.0.0

This version includes the following changes:

» Synchronize actions to finish simultaneously. An ALAP keyword has been added to the activity
specification to specify that parallel actions should be aligned on their end rather than their
start.

» Allow custom units to be defined for axes and setpoints in the machine specification.

» Updated the MotionCalculator API to allow more flexibility in providing custom motion profiles.

° This is a backwards incompatible API change that impacts existing custom
motion calculators.

The scan keyword has been removed from the activity specification. If your
current specifications make use of it, you will need to make some changes:
1. Create a custom motion calculator that provides a scan motion profile.

2. In the machine file, define a new Profile (e.g. called scan) and add it to the
paths that are used for scanning.
o NOTE: The machine specification now allows to assign multiple motion
profiles to a path by means of the profiles keyword.

3. In the activity file, replace the scan keyword with move and use the scan
profile instead of the original profile.

4. In the settings file, define the motion settings for the scan profile that uses
the scan motion profile of the custom motion calculator, see step 1.

* Removed "ProM export utilities for Conformance Check

This version also contains various bug fixes.

13.3. LSAT v1.0.1

This version only contains bug fixes that allow LSAT to be used as base for customer specific
extensions.
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13.4. LSAT v1.0.0

This is the initial version as created as part of the Concerto project.
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